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The Center for Practice Management is here to help you. 
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provide consultations exclusively to NCBA members
publish articles on the Blog,
send out the subscription based weekly newsletter
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Mischief Managed: 
Taking Control of Your Inbox
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Presenter Notes
Presentation Notes
Email is dead, long live email. Managing all of our messages has become even trickier with the addition of communications flying at us not only via email but also text, chat, social media, and more. The inbox remains, however, our correspondence hub. In this session we will discuss techniques to remain responsive, triage our tasks, and find ways to control the signal to noise ratio. 



Presenter Notes
Presentation Notes
Declaring inbox bankruptcy isn’t an option for lawyers and many professionals. Neither is this.



Email philosophy 
condensed

• Deal with email once
• Read and delete (or just delete)
• Read and act (if under 2 minutes)
• File/Flag for later action
• Defer/delegate

• Filter noisy, frequent, or non-urgent 
items

• Schedule a time to check e-mail
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Defer/Act/File/Toss or Read/Act/File/Toss



Getting a response to 
your email

• Descriptive subject line
• Main points at the top
• Close the loops

• E.g. use MeetingWizard, Google docs 
form, y/n questions or surveys, make 
recommendations

• five.sentenc.es
• Send links
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Pyramid Principle by Barbara Minto – 
Situation – describe what is the current situation (Subject)
Complication – describe the tension / issue in the situation (keep it brief)
Question – describe the question in response to the issue / tension
Answer – suggest answer to ease out or mitigate the issue / tension

Five.sentence.es – treat all email like text messages



Anatomy Of A 
“Whoops” 
Moment

Presenter Notes
Presentation Notes
Terraphase Engineering, Inc. v Arcadis, U.S., Inc., ’11
Two-word ‘reply all’ email leads to suspension for Atlanta prosecutor, ‘14
IN lawyer suspended for a year after privately criticizing judge, ’13
Lawyer sends a WSJ reporter privileged documents, ’17
Appellate court hears suit against lawyer – and his law firm - for breach of fiduciary duty and malpractice that started with an email to incorrect recipient, ’18

In Terraphase Engineering, Inc. v Arcadis, U.S., Inc., engineers employed at defendant Arcadis made plans to leave the company to form their own competing entity and began consulting an attorney via email. After leaving Arcadis, the engineers filed suit to enjoin their former employer from intruding in their new business. Their attorney continued to email one of the engineers at his Arcadis account because that was the address his email system supplied when he typed the first few letters of his client’s name. The engineers learned of this inadvertent disclosure when Arcadis filed a counterclaim referring to information that was only disclosed in post-resignation emails. In response, they filed a motion for a protective order that would effectively disqualify anyone at Arcadis or its defense counsel who had read the emails. The court granted plaintiffs’ motion, disqualifying the defendant’s outside law firm as well as certain in-house lawyers, and awarding costs and fees.
https://www.millercanfield.com/resources-alerts-735.html 
https://www.ediscovery.co/ediscoverydaily/case-law/ediscovery-case-law-read-inadvertent-email-get-disqualified-from-case/ 


More:
ABA article: two-word ‘reply all’ email leads to suspension for Atlanta prosecutor
http://www.lexology.com/library/detail.aspx?g=bc0a789c-7abe-47a4-98c6-851804c3aa5d 


http://www.abajournal.com/news/article/oops._lawyer_accidentally_copies_court_on_email_about_its_ill-conceived_and/ 

https://abovethelaw.com/2008/02/an-email-oopsie-by-a-legendary-litigatrix/

http://www.abajournal.com/news/article/nyt_reporter_says_lawyers_e_mail_goof_not_a_big_blunder  

http://www.abajournal.com/news/article/sued_by_dla_piper_for_675k_ex-client_discovers_lighthearted_churn_that_bill/\

Others: https://abovethelaw.com/email-scandals/page/12/   





The Culprits

• Auto-complete feature in email applications
• Reply vs. Reply All
• BCC
• Emailing from mobile devices
• Lack of attention
• Poor impulse control
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Most of the mistakes you make while emailing stem from a batch of usual suspects. 

Auto-complete – When you start to type in someone’s name in the send field of an email, most platforms finish filling in the name for you based on your contacts. This makes it remarkable easy to email the wrong person, or email the right person at the wrong address.
Reply vs. reply all – Especially when you’re on your phone, it’s extremely easy to mindlessly press “reply” or “reply all” without paying attention to what you’re selecting. These are different, and that difference matters. 
BCC – You BCC on an email thread. The BCC’d person hits “reply all,” thus alerting everyone else that you included them in secret. It’s embarrassing, and very avoidable. More on why you just plain shouldn't use BCC later.  
Phones – You’re much more likely to make a mistake when you’re distracted or in a hurry, and you’re much more likely to be either of those things when you’re emailing from your phone. 
Lack of attention – So many of our emails are sent when we’re in a hurry, and susceptible to small mistakes we wouldn’t otherwise make. 
Poor impulse control – An email makes us angry, and we immediately reply – it’s a recipe for disaster. 



What 
About 
MS 
Outlook 
Recall?
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From a sent message click on Move – Actions – Recall this Message

IF the person, within your own MS Exchange environment, has not yet read the message this will effectively delete the message. Otherwise, you will get notification that recall failed.

Outside your MS Exchange environment (aka anyone outside the firm) Recall does not work and the person will see the original message and another message alerting them that you wanted to recall it. 

Good news: Microsoft may be making this actually work: https://youritconsultant.senseient.com/2019/12/message-recall-for-office-365-coming-to-exchange-online.html



10 Seconds to Undo



Turn off 
Autocomplete



Easily Remove Address From Auto Correct
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General Settings (gear icon in the top right) under Privacy and Data there is a section called Suggested People


More Control Over Email Address from Suggestions
In the General Settings (gear icon in the top right) under Privacy and Data there is a section called Suggested People. This is the dangerous but useful feature that shows suggested names from your address book, contacts, and addresses based on your email conversation and activity. Now you have the possibility to clear the auto complete list of the addresses that fill in based on your email conversations and activity. Click “clear data and turn off”. They offer the option of downloading the expanded people data before you take this step, as you can’t recover the list once you delete it. Now the suggested email addresses that appear will be restricted to only those in your organization’s address book or your personal contacts. 
Two other improvements regarding suggested people. When you add an address to an email anyone outside of your organization is highlighted in yellow. If you want to remove an address from the auto complete list without turning off the setting, click on the X to the right of the name on the list of addresses that populates to the right. A warning will pop up and ask if you are sure you want to remove this address from your suggestions and search results. This is very handy if a contact has changed their email address, but their old email address continues to populate.




BCC – Just 
Don’t do it
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Don’t BCC. I know there are some reasons, but they are few and there are better ways (like using Mailchimp or if you need to send a bunch you can use Word Mail Merge and email a group individually). 


New York State Bar Association
Committee on Professional Ethics
Opinion 1076 (12/8/15)
Topic:  	Email; blind copy of correspondence; communication with client.  
Digest:  	A lawyer may blind copy a client on e-mail correspondence with opposing counsel, despite the objection of opposing counsel. Because a lawyer is the agent of the client, sending such a blind copy is not deceptive.  However, there are practical reasons why the lawyer should consider forwarding the e-mail correspondence to the client rather than using “bcc”.
http://www.nysba.org/CustomTemplates/Content.aspx?id=60757 
 
Charm v. Kohn, Superior Court of Massachusetts, Sept. 30, 2010
The practice of blind copying a client with a letter to adverse counsel, or to the Court, has long been common practice to keep clients contemporaneously informed on the progress and status of their pending legal matters. In the paper world, a blind copy of a letter to adverse counsel raised few, if any, issues. In the electronic age, however, the practice of blind copying a client on communications to another can have embarrassing, indeed, devastating, unintended consequences. Consider the plight of Eugene Kohn. Mr. Kohn found himself embroiled in litigation against a former business colleague. (Charm v. Kohn, Superior Court of Massachusetts, Sept. 30, 2010). Mr. Kohn’s attorney sent an e-mail to adverse counsel, and bcc’ed his own client, Mr. Kohn. Mr. Kohn replied to his attorney’s e-mail with a communication that was obviously intended to be a confidential attorney-client communication. However, Mr. Kohn mistakenly used the “reply all” function and sent his otherwise confidential communication with his own lawyer to the adverse attorneys. The question before the court was whether a client’s own inadvertent disclosure of an otherwise privileged communication to adverse counsel constituted a waiver of the attorney-client privilege.
 
http://www.wilentz.com/files/articlesandpublicationsfilefiles/275/articlepublicationfile/tonrey%20taylor%20news%20letter%20-%20how%20blind%20is%20a%20bcc%20april%202011.pdf 




“Mail Merge”
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Presentation Notes
create a new outbound message in the Send menu click the arrow and choose “Start Mail Merge”

Mail Merge
Microsoft has hinted that there will be a fully baked mass mailing option coming soon, but in the meantime, this is a handy new feature. If you need to send an email to multiple parties but don’t want to BCC for fear of a recipient hitting “reply all” and inadvertently creating issues (confidentiality, privilege, represented third parties), when you create a new outbound message in the Send menu click the arrow and choose “Start Mail Merge”.  The “to” line changes to “recipient” and a notification shows up to let you know that every recipient will receive their own copy of this email without the other recipients listed. 




MS Outlook - Organize 
& Customize



Options
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Many time management articles suggest that opening email first thing to start your work day distracts you from first planning your day and what you need to get done. You will react to a message first and possibly lose your way in your prioritized tasks. Eliminate the temptation to look at new email first by changing the default open view in MS Outlook.

In MS Outlook go to File – Options – Advanced and go to “Outlook start and exit”.  Click the “browse” button to choose an alternate starting point, like your calendar or tasks/to-do list.  Then click “ok” at the bottom and the next time you close and re-open Outlook it will open to your new starting point and not in your inbox!



Focused inbox

• Focused Inbox separates your important 
emails into a "Focused" tab, while less 
important emails go to the "Other" tab
• The system learns what is important
• You also can train the designation
• Use the right click menu to move messages 
to the other tab and to designate importance
• Set up in Focused Inbox sorting in the  View 
menu settings



Ignore Conversations 

• For conversations that don’t need to 
involve you
• Moves email threads directly to the 
Deleted Items folder
• Future messages will be discarded 
too
• Emails with the same subject are 
considered part of the conversation
• Use carefully – undoing is hard



Sort (and Destroy)
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Sort your inbox by “From” and you can easily delete or move hundreds of messages. Also sort by “cc” and “subject”.  You can add sort fields by right clicking on the field row and clicking “Field Chooser” and dragging other fields to sort by, such as “to”.



Pin an email to the top

• Pin important emails to the top of your 
inbox for quick access

• Right click an email to display the Pin 
feature on the list of options



Snooze feature

• Snooze emails until later

• Temporarily removed from your inbox 

• Returned at an appropriate time that 
you determine

• Stored in a folder named Snoozed if you 
need to retrieve early



Conditional Formatting Is Easier to Find
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Settings (gear icon) go to Mail – Conditional formatting.

Conditional Formatting
Want to highlight an email from a particular person with a distinct color to make it stand out? New Outlook has a dedicated button for conditional formatting. In Settings (gear icon) go to Mail – Conditional formatting. Give your rule a name, add conditions (from, subject includes, etc.) and add conditions to further refine the conditional formatting. Then pick a color and save. Now emails that meet the conditions will appear in the color of your choice. In classic Outlook you had more options, like changing the font size and type, but it was difficult to find the settings to apply conditional formatting as it was buried in advanced View settings. 




Voting buttons

• Voting buttons provide more options
• Allow you to create polls within your 

emails
• Easily gather opinions and decision 

feedback
• Votes from responders will be 

returned to you for review 



Scheduling polls

• When trying to arrange a meeting, a 
scheduling poll can help to find the best 
meeting times 

• Outlook will show times when 
recipients appear to be available

• The invited participants can provide 
feedback on their preferred times

• Minimizes the  back-and-forth of 
scheduling



Templates
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Replaces QuickParts, kinda. Cold comfort for losing autocorrect



Calendar & Tasks



Drag an Email to Calendar/Task/Contact
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As you sort through emails if the email is about a meeting drag it to your calendar. The body of the email, any attachments, etc. will be in the calendar event. And don’t worry, you can find it all again. 



Flag Email for 
Follow-up
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For Follow Up or Categories  in MS Outlook

To deal with messages you choose to “defer” you can right (alternate) click on the flag item to flag the message to follow up. You can set a custom time limit on the deferment, and set a reminder. Any e-mail message that includes a flag appears in the “For Follow Up” Search Folder as well as the To-Do Bar in Outlook.  Be careful when using the flags in Outlook however.  Many users think that if they flag it and it shows on their task list on the To Do bar that it will remain there if deleted from their email.  It does not.  If you delete the email, it deletes the task as well.  Therefore, it may be wiser to drag and drop the email to your task list and flag or categorize it there.  That way you can delete the email and not worry about it being removed from your tasks.




New Out of Office Options
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Presentation Notes
Go to the gear icon in the upper right corner, click on “Accounts” and then choose “Automatic replies”

New Out of Office Options
You have some new and helpful settings in the Out of Office auto reply settings. Go to the gear icon in the upper right corner, click on “Accounts” and then choose “Automatic replies”. You can still set the date and time when the auto reply goes out and send different responses within your organization and outside your organization. Once you click on the box to “Send replies only during a time period” three new options appear: Block my calendar for this period; Automatically decline new invitations for events that occur during this period; Decline and cancel my meetings during this period. This is super duper handy for standing meetings that you may forget to cancel if you are out of the office for a few days. 




Reply with Calendar Invites Not Emails

This

Not 

This
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Sending a calendar request to a meeting, teleconference or webconference helps ensure that the participants have it on their electronic calendar and have the information they need to participate. Users of any calendar program from Outlook, Google or Apple should be able to send a meeting request that can be opened and applied to the recipients calendar. If not, the recipient will still receive the pertinent information.  Be sure to include the location information, including dial in and login information in the “location” area of the invitation, as well as in the body or notes field of the request so that people will not be late because they couldn’t find the information they needed to participate.


Meetings can be time wasters
Always have an agenda
Always have a scheduled end time
Formal meetings require minutes, but most work meetings should result in tasks, assignments and deadlines.
Avoid scheduling meetings mid-morning or mid-afternoon because that breaks up time for large projects.




Send Calendar Invites Not Emails

This

Not 

This

Presenter Notes
Presentation Notes
Sending a calendar request to a meeting, teleconference or webconference helps ensure that the participants have it on their electronic calendar and have the information they need to participate. Users of any calendar program from Outlook, Google or Apple should be able to send a meeting request that can be opened and applied to the recipients calendar. If not, the recipient will still receive the pertinent information.  Be sure to include the location information, including dial in and login information in the “location” area of the invitation, as well as in the body or notes field of the request so that people will not be late because they couldn’t find the information they needed to participate.


Meetings can be time wasters
Always have an agenda
Always have a scheduled end time
Formal meetings require minutes, but most work meetings should result in tasks, assignments and deadlines.
Avoid scheduling meetings mid-morning or mid-afternoon because that breaks up time for large projects.




Duplicate an event

• Duplicate a calendar event to create 
another similar meeting 
• No need to start from scratch or copy 
and paste
• Open meeting to be duplicated and 
select Duplicate event in top menu
• If creating a new virtual meeting, first 
turn off the Zoom or Teams option and 
remove the meeting ID from the notes 
field
• A new meeting ID can be created after 
entering the other details 



Additional time zones

• Add multiple time zones to your 
calendar to manage meetings across 
different regions more effectively

• Swap where zones are displayed to 
help you stay oriented when away





Meeting 
Insights in 
MS Outlook 
Calendar

Presenter Notes
Presentation Notes
If you have been emailing with someone and they send you a meeting request the emails pertaining to the event will show up under “meeting insights”



Automate



MS Outlook -  Quick Parts

Presenter Notes
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Sent it twice already? Save it to QuickParts!



Quick Steps 
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Presentation Notes
Quick Step for autoresponse
Example: “Busy”

1.) Create a New Quick Step Called “I’m busy”
2.) The first action is “reply”
3.) Click “Options”
4.) In “Options” add text example: “I’m not able to respond adequately right now but I’ll get back to you as soon as possible. If you need immediate assistance please reply all to reach my assistant XXXX who is copied on this response. I have flagged your message to follow up.”
5.) Add Cc: the assistant’s email
6.) Then Add Action “Flag Message”



MS Outlook - 
Sending Your 
Schedule
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Presentation Notes
New Email, Insert calendar, choose parameters, off it goes. Only works if your calendar is used. Or use YouCanBookMe or ScheduleOnce or Doodle. 




More 
Intelligence in 
Contacts
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Presentation Notes
When you double click on an email address

Files and Messages in Contacts
When you double click on an email address, whether the person has been saved to your contacts or not, you can see contact information, recent messages (email or Teams) from that contact, and also files that were recently shared with you from that contact. That information is quite handy, as are meeting insights at the bottom of calendared events.




More 
Intelligence in 
Contacts



Selected Text Functions
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Select Text Floating Menu
When you select text in an email a little menu appears. You can highlight the text, add it to a OneNote feed that ties back to the entire email, respond to the email with the selected text called out, or add a task in To Do with the selected text in the task and linked to the email. 




Schedule Send
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Presentation Notes
Was Delay Delivery



Power 
Automate 
F/K/A Flow
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Microsoft Flow
https://flow.microsoft.com/en-us/

Save a copy of email attachments to a folder automatically depending on criteria
Send a copy of an email from a specific person to a MS Teams channel

See blog post!




Search & Categorize



Search

Presenter Notes
Presentation Notes
Search is powerful! Default search is to search the current folder, but you can easily change that to search other folders, and even other Outlook items (like your calendar).



Immersive Reader

• Can make long emails easier to read
• A view option



MS Outlook  
- Search 
Folders

Presenter Notes
Presentation Notes
Find email from your team, faculty, lawyers etc. for constant access.



Put Your Folders In Any Order

Presenter Notes
Presentation Notes
In the View tab click on Folder Pane – Sort Folders – Custom Folder Order. 

Custom Folder Orders
You can add folders to Favorites, so they are always in view at the top of the list in the left folder panel. But for your complete list of folders, they are organized alphabetically. To force a folder to appear towards the top of the list you can use characters and numbers, like / or 1, to display the folder higher in the alphabetized list. Now, in the new Outlook, you can organize your folders however you want to! In the View tab click on Folder Pane – Sort Folders – Custom Folder Order. Then you can drag and drop your folders in whatever order works best for you. 




Outlook -  
Create 
Categories 



Outlook – Sort by Categories



Outlook – Search for Categories



Favorite Categories
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Settings – Accounts – Categories - Favorite



Outlook – Create Search Folder for Category



Finding Related Emails 
is Easier
Instead of sorting emails by sender

Use Find related function instead

Find messages from the same sender in the 
same way as Message in this conversation

A more logical placement of an old function

Managing the entire group is easier



Sweep Messages
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Open a message or select on from a list and click “Sweep” (Move group in the Home tab)

Sweep Messages
Sweep is essentially a rule, but Microsoft has added it as a stand-alone button in the Ribbon (Move group in the Home tab). Open a message or select on from a list and click “Sweep”. You will see a list of options: to move all the messages from the Inbox folder to a folder or your choice; move all messages from the inbox folder and any future messages to a mailbox of your choice; always keep the latest message and move the rest from your Inbox folder to a folder of your choice; or Always move messages older than 10 days from the Inbox folder to a folder of your choice. 




Move to Folder
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Presentation Notes
Ctrl + Shift + V 

Move to Folder
To help you clean up your inbox without having to drag and drop, simply select the email messages you want to move and then click on “Move” in the ribbon. It will show a list of recently used folders, or you can type the name of the folder. From this menu you can also add a new folder or see your entire folder structure. Want to move messages at once upon receipt? Select the message and click V (web shortcuts) or Ctrl + Shift + V (Outlook for Windows shortcuts) to make the Move option appear as a floating control.




QUESTIONS?

Email Catherine at 
csandersreach@ncbar.org
Call or text 919-657-1577

Catherine Sanders Reach, MLIS
Director, Center for Practice Management
North Carolina Bar Association

https://www.ncbar.org/cpm
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If I can ever be of assistance please don’t hesitate to let me know. I’m looking forward to a great bar year with you. 

mailto:csandersreach@ncbar.org

